
Elmer/Ice – New Generation Ice Sheet Model

Elmer/Ice course Oslo, November 2016

1



Elmer/Ice – 2D glacier toy model

Thomas Zwinger



2D GLACIER TOY MODEL

This session shall introduce into the basics of Elmer/Ice. It follows the 
strategy of having a possibly simple flow-line setup, but containing all 
elements the user needs in real world examples, such as reading in 
DEM’s, applying temperature and accumulation distributions, etc.
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DIAGNOSTIC RUN

Starting from a given point-distribution (DEM) in 2D we show how to

• Build the geometry and mesh it

• Set up runs on fixed geometry

• Introduce sliding

• Introduce heat transfer (thermo-mechanical coupling)

• Write a simple MATC function (interpreted functions)
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The diagnostic problem

 We start from a 
distribution of 
surface and 
bedrock points 
that have been 
created driving a 
prognostic run 
into steady state

 The distributions are given in the files: 
steady_ELA400_bedrock.dat , steady_ELA400_surface.dat
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The diagnostic problem
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The Mesh

 Using Gmsh

 Simply launch by: 

 $ gmsh testglacier.geo &

 Don’t use the existing one in the  Solution-
folder, since we want to keep it as a backup, 
should this one fail
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The Mesh
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The Mesh
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The Mesh

Press on left point, until it is highlighted ▪

Press on right point
and the line should appear
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The Mesh

Klick on the line and it should be 
highlighted 

As suggested above, press e
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The Mesh

 Gmsh does journaling into the geo-file
 it immediately writes out your entries

 This means, that you can drive Gmsh also solely via script

 It also means that you can make changes and reload

 Before you load:
 Tools →Options: go to tab Advanced

 Under Text editor command: sensible-editor
to emacs
 You should do a File→Save Options As Default

 Geometry →Edit file
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The Mesh

• Save the changes

• In Gmsh:
Geometry →Reload
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The Mesh

Klick on the surface to highlight the dashed 
lines (zoom first with mouse wheel)

Following suggestions from top, and press e
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The Mesh

1

2

3

4

 You have to zoom (mouse wheel) in and out of the 
model

 and  translate (right mouse button)
 Select boundary in the given order (highlights in red) 

and press “e” every time
 If you selected  the wrong boundary, use “u” to unselectElmer/Ice course Oslo, November 2016 15



The Mesh

 Finally, mesh the geometry: Mesh→2D

 And save the mesh: Mesh→Save
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The diagnostic problem
• We use a ~11 deg inclined rectangular mesh 

(produced with Gmsh) of unit-height (load the 
ready-made file
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The diagnostic problem

• If you have not already saved the mesh from 
Gmsh, do the following: 

$ gmsh -2 testglacier.geo

• Use ElmerGrid to convert the mesh:
> ElmerGrid 14 2 testglacier.msh\

–autoclean –order 0.1 1.0 0.01

Orders the numbering in x 
y z –directions (highest 
number fastest)

Needed to 
clean up 
geometry
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The diagnostic problem

• We will do a diagnostic simulation, i.e., we 
ignore the time derivative in ANY equation
– Stokes anyhow has no explicit time dependence

– That also means, that the surface velocity 
distribution is a result of the given geometry and 
cannot be prescribed (no accumulation)

• Open the Solver Input File (SIF)

$ emacs Stokes_diagnostic.sif &
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The diagnostic problem 

This declares our mesh; capital/small letters matter

Steady State = diagnostic

The coordinate system (inkl. Dimension)
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The diagnostic problem 

Assigns the Equation/Material/Body Force/and Initial conditionto a body

Well, as the name suggests: initial values for variables

The Equation for Body 1 (see above); declares set of Solvers
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On Bodies and Boundaries
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On Bodies and Boundaries

• Each Body has to have an 
Equation and Material
assigned
– Body Force, Initial 
Condition optional

• Two bodies can have the same 
Material/Equation/Body 

Force/Initial Condition 

section assigned

Body 1Body 2

Material 1

Body Force 1

Material 2

Equation 1
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The diagnostic problem 

The primary criterion for order of execution is the Exec 
Solver keyword, thereafter the numbering

This solver simply projects the shape given in the input files 
before the run (see Exec Solver keyword) to the initially flat mesh;
See Top Surface and Bottom Surface keywords later 
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The diagnostic problem 

Solver 3 

Equation = "HeightDepth"

Procedure = "StructuredProjectToPlane" "StructuredProjectToPlane" 

Active Coordinate = Integer 2

Operator 1 = depth

Operator 2 = height

End

Flow Depth this time for post processing, only, 
on generally unstructured mesh (will be 
replaced by structured version)Elmer/Ice course Oslo, November 2016 25



Linear System Solver keyword chooses type of 
solution of the linearized problem

The diagnostic problem 

You need that in Stokes and also in PDE’s with significant 
amount of convection

Account for non-linearity of the rheology 

4
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On iteration methods
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This is for scaling reasons (see next slide)

The diagnostic problem 

where and
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For the Stokes problem, one should give values for:

- the density:

- the gravity: 

- the viscosity: 

Elmer(/Ice) does not assume any choice of units. This is on you, BUT, units have to 
be consistent amongst each other and with the mesh geometry units. 
The order of magnitude in numbers do not change results, as matrix is pivoted

kg – m – s [SI] :  velocity in m/s and time-step in seconds

kg – m – a :  velocity in m/a and timesteps in years

MPa – m – a : velocity in m/a and Stress in MPa  

(What we have in our SIF)

On the choice of units
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On the choice of units

To give you an example: for ISMIP tests A-D, the value for the 

constants would be 

- the density: 

- the gravity: 

- the fluidity: 

USI kg - m - s  kg - m - a

g = 9.81 9.7692E+15 9.7692E+15

 = 910 910 9.1380E-19

A = 3.1689E-24 1.0126E-61 100

5.4037E+07 1.7029E+20 0.1710

MPa - m - a

m / s2 m / a2 m / a2

kg / m3 kg / m3 MPa m-2 a2

kg-3 m3 s5 kg-3 m3 a5 MPa-3 a-1

 = kg m-1 s-5/3 kg m-1 a-5/3 MPa a1/3
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We set our glacier to be at -3 C

The diagnostic problem 

Now commented, needed later

Gravity, scaled to deliver results in 
m/a and MPa

Elmer/Ice course Oslo, November 2016 31



The diagnostic problem

• Boundary conditions:
– using array function for 

reading surfaces
– Real [cubic] expects 

two columned row:
x1 z1
x2 z2
…

– include just inserts 
external file (length)

– Right values interpolated 
by matching interval of 
left values for input 
variable
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The diagnostic problem 

• Now, run the case:

$ ElmerSolver Stokes_diagnostic.sif

– You will see the convergence history displayed:

FlowSolve: -------------------------------------

FlowSolve:  NAVIER-STOKES ITERATION          23

FlowSolve: -------------------------------------

FlowSolve: 

FlowSolve: Starting Assembly...

FlowSolve: Assembly done

FlowSolve: Dirichlet conditions done

ComputeChange: NS (ITER=23) (NRM,RELC): (  1.6112696     

0.90361030E-03 ) :: navier-stokes

FlowSolve: iter:   23 Assembly: (s)    0.26    6.04

FlowSolve: iter:   23 Solve:    (s)    0.11    2.62

FlowSolve:  Result Norm     :    1.6112695610649261

FlowSolve:  Relative Change :    9.0361030224648782E-004
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The diagnostic problem 

• Post-processing using ParaView: $ paraview
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The diagnostic problem 

• File → Open  stokes_ela400_diagnostic0001.vtu
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The diagnostic problem 

• Apply
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The diagnostic problem 

• Change to velocity

Press to 
activate
colour 
bar 
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The diagnostic problem 

• Scale
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The diagnostic problem 

• Change colours

1.

2.

3.
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Sliding

• Different sliding laws in Elmer

• Simplest: Linear Weertman
– This is formulated for the traction     and velocity      in 

tangential plane

• In order to define properties in normal-tangential 
coordinates: Normal-Tangential Velocity = True

• is the Slip Coefficient {2,3} (for the tangential 
directions 2 and 3) (for 3D, in 2d only direction 2)

• Setting normal velocity to zero (no-penetration) 
Velocity 1 = 0.0
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Sliding

• Now we introduce sliding

– We deploy a sliding zone between z=300 and 
400m

Use normal-tangential 
coordinate system Definition of slip 

Coefficient
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Sliding

Replace the FlowDepth Solver with this one. This solver simply 
uses the vertically structured mesh to inquire the Depth/Height 
without solving a PDE (much cheaper).  
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Sliding

• Restart from previous run (improved initial 
guess)

Take last entry
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The diagnostic problem 

• Now, run the case:

$ ElmerSolver Stokes_diagnostic_slide.sif

– Converged much earlier:

FlowSolve: -------------------------------------

FlowSolve:  NAVIER-STOKES ITERATION          12

FlowSolve: -------------------------------------

FlowSolve: 

FlowSolve: Starting Assembly...

FlowSolve: Assembly done

FlowSolve: Dirichlet conditions done

ComputeChange: NS (ITER=12) (NRM,RELC): (  3.4915753     

0.34732117E-05 ) :: navier-stokes

FlowSolve: iter:   12 Assembly: (s)    0.32    3.53

FlowSolve: iter:   12 Solve:    (s)    0.12    1.38

FlowSolve:  Result Norm     :    3.4915753430899730

FlowSolve:  Relative Change :    3.4732116934487441E-006

ComputeChange: SS (ITER=1) (NRM,RELC): (  3.4915753      

2.0000000     ) :: navier-stokesElmer/Ice course Oslo, November 2016 44



Sliding

• Load parallel to previous file

• File → Open  
stokes_ela400_diagnostic_slide0001.vtu
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Sliding

1.

2.
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Sliding

Scale 
also this 
one
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Heat transfer

• Adding heat transfer:

– Add ElmerIceSolvers TemperateIceSolver

with variable name Temp (see next slide)

– Surface temperature distribution: linear from 
273.15 K at z=0m to 263.15 K at z=1000m

– Geothermal heat flux of 200 mW m-2 at bedrock

Temp = Variable Coordinate 2

Real

0.0   273.15

1000.0   263.15

End 

Temp Flux BC = Logical True

Temp Heat Flux = Real $ 0.200 * (31556926.0)*1.0E-06Elmer/Ice course Oslo, November 2016 48



Heat transfer

Solver 5

Equation = String "Homologous Temperature Equation"

Procedure =  File "ElmerIceSolvers" "TemperateIceSolver"

Variable = String "Temp"

Variable DOFs = 1

Stabilize = True

Optimize Bandwidth = Logical True

Linear System Solver = "Iterative"

Linear System Direct Method = UMFPACK

Linear System Convergence Tolerance = 1.0E-06

Linear System Abort Not Converged = False

Linear System Preconditioning = "ILU1"

Linear System Residual Output = 0

Nonlinear System Convergence Tolerance = 1.0E-05

Nonlinear System Max Iterations = 100

Nonlinear System Relaxation Factor = Real 9.999E-01

Steady State Convergence Tolerance = 1.0E-04

End
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Heat transfer

• Material parameters in Material section

• Using defined MATC-functions for

– Capacity:

– Conductivity: 

Material 1

…

! Heat transfer stuff

Temp Heat Capacity = Variable Temp

Real MATC "capacity(tx)*(31556926.0)^(2.0)"

Temp Heat Conductivity = Variable Temp

Real MATC "conductivity(tx)*31556926.0*1.0E-06"

End
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Heat transfer

• Material parameters in Material section

• Using defined MATC-functions for

– Capacity:

– Conductivity: 

!! conductivity

$ function conductivity(T)  { _conductivity=9.828*exp(-5.7E-03*T)}

!! capacity

$ function capacity(T) { _capacity=146.3+(7.253*T)}
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Heat transfer

• Now, run the case:

$ ElmerSolver Stokes_diagnostic_temp.sif

• It goes pretty quick, as we only have one-way 
coupling and hence don’t even execute the 
Stokes solver

Solver 3

Exec Solver = "Never" ! we have a solution from previous case

Equation = "Navier-Stokes"
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Heat transfer

• Due to high 
geothermal 
heatflux we 
have areas 
above 
pressure 
melting point

• We have to 
account for 
this
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Heat transfer

• Constrained heat transfer:

– Including following lines in Solver section 
ElmerIceSolvers TemperateIce

! the contact algorithm (aka Dirichlet algorithm)

!-----------------------------------------------------

Apply Dirichlet = Logical True

! those two variables are needed in order to store

! the relative or homologous temperature as well

! as the residual

!-------------------------------------------------

Exported Variable 1 = String "Temp Homologous"

Exported Variable 1 DOFs = 1

Exported Variable 2 = String "Temp Residual"

Exported Variable 2 DOFs = 1
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Heat transfer

• Constrained heat transfer:

– Also introduce the upper limit for the temperature 
(a.k.a. pressure melting point) in the Material 
section

Temp Upper Limit = Variable Depth

Real MATC "273.15 - 9.8E-08 * tx * 910.0 * 9.81"
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Heat transfer

• Now, run the case:

$ ElmerSolver \

Stokes_diagnostic_temp_constrained.sif

• Already from the norm (~ averaged nodal 
values) it comes clear that values are in 
general now lower

TemperateIceSolver (temp): iter:    5 Assembly: (s)    1.36    6.77

TemperateIceSolver (temp): iter:    5 Solve:    (s)    0.00    0.01

TemperateIceSolver (temp):  Result Norm   :    271.78121462656480

TemperateIceSolver (temp):  Relative Change :    

5.0215061382786350E-006

ComputeChange: SS (ITER=1) (NRM,RELC): (  271.78121      2.0000000     

) :: homologous temperature equation
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Heat transfer

ConstrainedUnconstrained
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Heat transfer

• Thermo-mechanically coupled simulation:

– We have to iterate between Stokes and HTEq.

– Coupling to viscosity in Material section

Steady State Max Iterations = 20

! the variable taken to evaluate the Arrhenius law

! in general this should be the temperature relative

! to pressure melting point. The suggestion below plugs

! in the correct value obtained with TemperateIceSolver

Temperature Field Variable = String "Temp Homologous"
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Newton Iterations

• We need Picard (=fixed-point) iterations instead of Newton 
iterations at the beginning of each new non-linear iteration 
loop 

Solver 1

!  Exec Solver = "Never"

Equation = "Navier-Stokes“

…

Nonlinear System Reset Newton = Logical True

!Nonlinear System Relaxation Factor = 0.75

End
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Heat transfer

Thermo-mechanically coupledUncoupled (constant T)
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PROGNOSTIC RUN

Starting from a deglaciated situation we show

• How to move to a transient run, i.e., introduce the

• Free surface solution

• Including coupling to climate via prescribing an accumulation/ablation 
function

• How to write a less simple MATC function



The prognostic problem

• Glacier with ~11 deg constant inclination

• Standard accumulation/ablation function

• Or in terms of ELA (equilibrium line altitude):

• We know lapserate,  , and          and have to 
define
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The Problem

• From x=[0 :2500], z=[0:500]

• Setting mesh with 10 vertical levels with 5m 
flow depth
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The Problem

• Flow problem  (Navier-Stokes) in ice

• Free-surface problem on free surface
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Time Stepping

Simulation

Max Output Level = 4

Coordinate System =  File "Cartesian 2D"

Coordinate Mapping(3) = 1 2 3

Simulation Type = "Transient"

Steady State Max Iterations = 1

Timestepping Method = "BDF"

BDF Order = 1

Timestep Sizes = 10.0    ! Delta t (Real) of one step

Timestep Intervals = 200 ! Amount (Integer) of steps taken 

Output Intervals = 10    ! Interval (Integer) of writing data

Post File = "Stokes_prognostic_ELA400_SMBonly.vtu“

Initialize Dirichlet Conditions = Logical False 

End

Elmer/Ice course Oslo, November 2016 65



Free Surface Equation

Solver 4

Equation = String "Free Surface"

Procedure =  File “FreeSrufaceSolver" “FreeSurfaceSolver"

Exec Solver = always

Variable = String "Zs"

Variable DOFs =  1

! needed for evaluating the contact pressure 

Exported Variable 1 = -dofs 1 "Zs Residual“

! needed for storing the initial shape (needed for updates)

Exported Variable 2 = -dofs 1 "RefZs"

Procedure = "FreeSurfaceSolver" "FreeSurfaceSolver“

! This would take the contrained points out of solution

! Use in serial run, only

! Before Linsolve = "EliminateDirichlet" "EliminateDirichlet"
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Free Surface Equation

Linear System Solver = Iterative

Linear System Max Iterations = 1500

Linear System Iterative Method = BiCGStab

Linear System Preconditioning = ILU0

Linear System Convergence Tolerance = Real 1.0e-7

Linear System Abort Not Converged = False

Linear System Residual Output = 1

Nonlinear System Max Iterations = 100

Nonlinear System Convergence Tolerance  = 1.0e-6

Nonlinear System Relaxation Factor = 0.60

Steady State Convergence Tolerance = 1.0e-03

Stabilization Method = Bubbles    

! Apply contact problem

Apply Dirichlet = Logical True

End
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Free Surface Equation

Body 2

Name = "Surface"

Body Force = 2

Equation = 2

Material = 2

Initial Condition = 2

End

Equation 2

Name = "Equation2"

Convection = "computed"

Active Solvers(1) = 3

Flow Solution Name = String "Flow Solution"

End
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Free Surface Equation

Boundary Condition 3

Name = "surface"

Top Surface = Equals "Zs"

Target Boundaries = 2

Body ID = 2

Depth = Real 0.0

End

t=0: Zs = RefZs

t>0:

Top Surface = Zs
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Free Surface Equation

• Starting with same values for both variables

• Using the latter to keep minimal height

Initial Condition 2

Zs = Equals Coordinate 2

RefZs = Equals Coordinate 2

End

Material 2

Min Zs = Variable RefZs

Real MATC "tx - 0.1"

Max Zs = Variable RefZs

Real MATC "tx + 600.0"

End
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Free Surface Equation

• And here comes the coupling to climate
Body Force 2

Name = "Climate"

Zs Accumulation Flux 1 = Real 0.0e0

Zs Accumulation Flux 2 = Variable Coordinate 1, Coordinate 2

Real MATC "accum(tx)"

End

$ function accum(X) {\

lapserate = (11.0/2750.0);\

ela = 400.0;\

atsl = -ela*lapserate;\

if (X(0) > 2500)\

{_accum = 0.0;}\

else\

{ _accum = lapserate*X(1) + atsl;}\
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The Solution

• Starting with no-flow problem, i.e., only surface mass balance, 
simply by setting Convection = “none” and (saves time) not 
executing Navier-Stokes, compare to run with coupled flow

• $ ElmerSolver Stokes_prognostic.sif
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USER DEFINED FUNCTION

In a follow-up session, by changing the previous setup we show

• How to write, compile and include a self-written user defined function

• How to introduce time changing variables
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User Defined Function

• Replace the MATC function with a user defined function (UDF)

• All UDF’s have the same header in Elmer(/Ice):
FUNCTION getAccumulation(  Model, Node, InputArray)RESULT(accum)

! provides you with most Elmer functionality

USE DefUtils

! saves you from stupid errors

IMPLICIT NONE

! the external variables

!-----------------------------------------------------------

TYPE(Model_t) :: Model ! the access point to everything 

about the model

INTEGER :: Node ! the current Node number

REAL(KIND=dp) :: InputArray(2) ! Contains the arguments passed 

to the function

REAL(KIND=dp) :: accum ! the result 

!-----------------------------------------------------------
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User Defined Function
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User Defined Function
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User Defined Function

Compilation is done with:
$ elmerf90 accumulation.f90 –o accumulation.so

The body-force section changes to:

Body Force 2

Name = "Climate"

Zs Accumulation Flux 1 = Real 0.0e0

Zs Accumulation Flux 2 = Variable Coordinate 2, Time

Real Procedure "accumulation" "getAccumulation"

End
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EXERCISE



Exercise

 If time permits, lets put all things together and 
make a thermo-mechanically coupled 
prognostic run. What do we need to add?
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